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Why Software Sucks (and What You an Do About It)

Electronic Mail (e-mail)
by Dale Atchison

Tampa Bay Computer Society

We all use it. It’s one of the reasons most of us
bought a computer in the first place, so we
could share jokes, music files, and pictures

of the grandchildren, depending on our age, with
friends and family. But, how many of us know how
to use e-mail courteously, safely, and efficiently?

Think for a minute how annoyed you get
when you receive an e-mail message that requires
you to ‘drill down’ through half a dozen or more
attachments to get to the actual message, be it text
or pictures. Then think just a little harder, and
remember that you usually just click on Forward to
send that monstrosity on to your own mailing

list—they’ll see every layer you did, plus one more!
ouch!

And how many e-mail
addresses have you seen of peo-
ple who received the message
before you? They’re most likely
friends of friends of friends, but
six or seven generations down
in the forwarding morass, and
there’s little chance they’re
someone you know, and cer-

tainly not someone whose e-mail address you should
be sending on to your mailing list. But you probably
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do, did, and will, if you just click on Forward. In this
article, I’m going to try and lay out a safe, courteous,
and efficient plan for sending e-mail. There’s nothing
you can do to fix how poorly your friends and family
handle the stuff they send you, but you can at least
keep from adding to the mess, and set a good exam-
ple at the same time.

1. Text Vs. Html.
First and foremost, there is seldom a good reason to
send HTML e-mail. That’s e-mail that lets you
choose the size, color, and font of your e-mail text, as
well as embed pictures and sound in a message.
When that’s something you just have to do for the
message to make sense, or just to express the feeling
or idea you were sending it for in the first place, go
ahead and use HTML, but most of the time, e-mail
should be sent in plain text format. Text messages
are a tiny fraction of the size of HTML messages,
meaning they upload from your computer and
download to the recipients’ computers in a fraction of
the time - your friends who still have dial-up will
thank you for not bogging down their downloads.
  • Sending in HTML just so you can use ‘smileys’ is

just plain wrong! I know one or two people who
actually like receiving all those stupid grinning
graphical characters; I ask them politely to
refrain from sending any to me. Both Hotmail
and Incredimail allow you to send e-mail without
HTML codes; sorry, but I can’t give any further
guidance than, “look for it,” because I don’t use
either program. (By the way, if you’re using
Incredimail, you’re taking a chance with all your
personal data—some of us think it’s spyware.)

  • When you want to embed pictures in a message,
and the placement and order matters, you don’t
get a choice. Use HTML, but make sure the end
result will be worth the annoyance and extra
download time to the people you’re sending to.
The same reasoning applies if you want to attach
an HTML ‘signature’ file: it won’t display prop-
erly at the end of a plain text e-mail, so if the
signature is worth the hassle, use HTML for the
message, as well. (of course, you could always
attach the HTML signature file to the end of a
plain text e-mail (see paragraph 6.), and you’d
get the best of both worlds-small message size,
with the attendant fast upload and download
times, and just one double-click necessary for the
recipient to see your HTML masterpiece at the
end.)

  • For most of us, it’s a good idea to set Plain Text
as the default mail sending format. Here’s how to

do it from within outlook Express: Tools » options
» Send » in the Mail Sending Format area, click
the Plain Text ‘radio button’. Click the HTML
Settings button, put a check mark next to Send
Pictures With Messages, and remove the check
mark next to Indent Message on Reply; click OK.
Click the Plain Text Settings button, remove the
check mark next to Indent the original Text, then
click OK, then OK again to save all changes.

  • And if someone sends you an HTML e-mail, and
you feel the need to respond to it, please remem-
ber to change the Format to Plain Text- they
might have had a legitimate reason to send you
a large file, but there’s no good reason to send the
same large file back to them just to say “Thanks,
that was funny.” While in the Reply window,
click on Format » Plain Text to lose the embed-
ded pictures, sounds, colors, and fonts. And
anytime you reply to a message, HTML or not,
only include as much of the original message as
absolutely necessary to remind the person why
you’re replying.

2. Layers of Attachments.
No matter how many layers you have to drill

through to get to a message, when you forward it,
the actual message (text or HTML) should be the
only thing the recipient sees. Using outlook Express,
this is very easy: don’t click Forward while looking at
the top layer of the message, but wait until you’re
looking at the last layer, the actual message; clicking
Forward at this point should open a new message
window with ONLY the ‘meat’ of the message dis-
played.

If you’re using AOL, CompuServe, YahooMail, or
one of the other web-based e-mail clients, it’s only a
little more complicated:
  • Don’t click on Forward, please! No one wants to

get all the names of those before you who re-
ceived this message.
Instead, while viewing the meat of the message

you want to send on to others, highlight everything
you want to forward by left-clicking just to the left of
the first word or picture, holding the mouse button
down, and dragging to just right of the last word or
picture.
  • Right-click anywhere in the highlighted area,

and left-click Copy.
  • Open a New Message, right-click in the blank

message body, and left-click Paste.
  • Send that message to your friends and family

trying not to send it to the person who sent it to
you - that denotes a whole new set of problems
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that I can’t help you with.
  • (Most of the web-based clients don’t give you the

option of ‘inline text’ for forwarding - it’s Send As

Attachment or no deal —another reason to use a
PoP3 client like outlook Express, Outlook,
Eudora, or Thunderbird.)

3. Addresses, keep them safe.
You have been trusted with the e-mail addresses

of your friends and family. Please don’t betray that
trust by sharing the address with the world. You
may only send a message on to one or two trusted
correspondents, but you have no way of knowing how
many they will send it to , and so on, and so on. How
many generations down the road before your maiden
Aunt’s e-mail address appears in the Inbox of some-
one who makes his living ripping off seniors? How
many times will a message be forwarded before your
daughter’s or niece’s address shows up where a
pedophile can use it to pretend he’s a trusted friend
of a trusted friend? This sounds paranoid—it isn’t.
Hide every e-mail address you use from every other
e-mail address you use, by putting all recipients’
addresses in the BCC: line; no one but the author of
the message ever sees those addresses - they’re not
even hidden in the headers that an administrator at
the receiving end can look at. The administrator at
your ISP (the sending end) can probably see them,
but he or she sees everything you do online, any-
way—you gotta trust somebody. If your e-mail client
won’t allow you to send a message with no address in
the To: line, address it to yourself, with all the real
recipients safely hidden in the BCC: line. In outlook
Express, the BCC: line isn’t displayed by default.
You can make it show up by clicking on the To:
button in a message (just left of the To: address line),
selecting an address from your Address Book, and
clicking on the BCC: button to add the address.
  • The only time it is appropriate to have a ‘pile’ of

addresses all visible to all recipients, either in
the To: or the Cc: lines, is when you know they
all know each other, you’re pretty sure none of
them would object to your sharing the address
with any of the rest of them, and the message is
of a nature that leaves you very sure there would
be no reason for anyone to forward it.

  • If you receive a message with other people’s
e-mail addresses visible, remove them all before
sending the message on. There’s no sense in
compounding someone else’s error by forwarding
the message ‘as is’. So what if one or two people
might receive a message twice because you or a

friend ‘downline’ didn’t see that they’d already
gotten it? That’s a small price to pay for protect-
ing your loved ones from predators. If they see a
duplicate message show up, and recognize the
Subject: line, they can erase it just as easily
before they read it as they could afterward.

4. The Subject Line.
Which brings me to the next topic: Always Type

Something Descriptive in the Subject Line. It’s only
common courtesy. When your friend who never
cleans out his Inbox wants to find the message you
sent him about your new Fender Stratocaster, it will
help immensely if the Subject: line includes the word
“Stratocaster”.
  • “News From the Bellsouth Portal” or such is

never adequate; news about what? If your Sub-
ject: line was filled in automatically by an online
script (meaning you pressed a “share this with a
friend” button), change it manually rather than
adding to it—a super-long subject line will be
ignored by most folks.

  • And please remove all those Fw: and/or Re:
prefixes on the Subject: line! They’re just clutter.
If you’re actually replying to a message, it’s okay
to have one (and only one) Re: before the Subject:
line; likewise, if this is a legitimate Fw: (someone
sent me this, and I think you should see it, too),
one and only one Fw: can appear before the
actual subject. Jokes, pictures, online stories, and
such should usually just have the subject, no Re:
and no Fw: . Makes for a cleaner message list in
the recipient’s Inbox.

5. Clean it up.
If you receive a message full of >>>>>> symbols,

remove them before passing it on. The instructions
in paragraph 1. will prevent you from adding an-
other > or two, but why not go the ‘extra mile’ and
remove the earlier senders’ mistakes by removing
them all? There is a program called E-mailStripper
that will do this for you [Also StripMail which is free
and easy to use. –Ed.], but I just use Notepad (In
Win 98 or ME, you’ll need to use WordPad - the
Replace function didn’t exist in Notepad until Win
2000.) Here’s how, using Notepad (WordPad com-
mands are the same, except for the obvious differ-
ence of calling the other program):
  • While viewing and want to clean up and forward,

click on the Forward button.
  • Press Ctrl-A on your keyboard) or click Edit »

Select All in the menu) to highlight the entire
message.
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  • Right-click any place within the highlighted area,
and left-click Cut.

  • Click on Start » Run » Notepad » OK.
  • Right-click anywhere on the blank page, and

left-click Paste. There’s your text.
  • While the text is still highlighted (if you lose the

highlighting, just press Ctrl-A on your keyboard
to get it back), press Ctrl-H.

  • In the Find What: field of the Find and Replace
dialog box, type a > symbol, followed by the
largest number of empty spaces you can see in
the highlighted text; leave the Replace With:
field blank, and click Replace All.

  • After the replacements have been made, click
once at the right-hand end of the Find What:
field, press the Backspace key, then click Replace
All again. • Repeat this process, reducing the
length of the Find What: string by one character
at a time, until there’s no text left in the Find
What: field.

  • Click the Cancel button in the Find and Replace
dialog box to close it.

  • Click Edit » Select All » Cut to put the cleaned-up
text ‘on the clipboard’.

  • Right-click back in your blank e-mail message,
and left-click Paste. You should be left with a
cleaned-up version of the original e-mail mes-
sage, ready to address and Send.
I realize these explanations seems long and

probably convoluted, but it took much longer to tell
you than it takes to do; once you’ve done it once or
twice, all the actions become automatic, and each
message takes just a few seconds to clean up.

Cleaning up an HTML message is a little bit
different. Instead of >> marks, some HTML mes-
sages that have been improperly forwarded have a
series of blue vertical bars at the left-hand side of
the screen. (We already set your copy of outlook
Express to not add to this mess back in paragraph 1.)
Remove the bars thusly:
  • Left-click just to the left of the first character or

picture in the html message that you want to
forward, and hold the button down while you
drag the mouse cursor to just right of the last
character or picture that you want. You should
now have a large highlighted area just to the
right of the last vertical blue bar on the left.

  • Right-click anywhere in the highlighted area,
and left-click Copy.

  • open a New Message window by clicking on
Create Mail.

  • Right-click in the blank message window, and

left-click Paste. There’s your original message,
minus all the blue bars and extra addresses.

  • Address the message (see paragraph 3.), add an
appropriate Subject: line (see paragraph 4.), and
click Send.

6. Attachments.
You can attach any file to an

e-mail message. (Some ISP’s
may not let your recipients re-
ceive executable files; if you
know that to be the case, ZIP
your .exe files and other exe-

cutables before attaching them.) Pictures attached to
a plain text e-mail will appear just below the text in
most e-mail clients. You won’t see it while composing
the message, but if you look at the message in your
outbox before sending it, it will (hopefully) look just
like it will when your friends receive it. Attach a file
by clicking on the Attach button in a New Message
window, navigating to the file(s) you want to attach,
and clicking the Attach button in the Insert Attach-
ment dialog box; you can attach more than one file at
a time, just highlight all the files you want to attach
using the Shift or Control keys, or by drawing a box
around a group of files in the dialog box.
  • If you attach files you created on your computer,

be sure the people you’re sending to have the
necessary programs to open the files installed on
their computers. Everyone has WordPad or its
Mac equivalent; convert any Word documents to
Word for Windows Version 6 using the Save As
command from the Word menu so they can see
your work. Also a Word file for a Mac recipient
should be saved as an RTF (rich text format) file.
Programs like Photoshop and Print Shop use
their own file formats by default, but if you’ll
check their menus, you’ll find you can export any
files you’ve created as JPEG or PDF files—again,
everyone can read those.

  • Sometimes, you’ll see a picture in an incoming
e-mail, but it will show up as a red X when you
try and forward it. This can happen for any of
several reasons, but one of the most likely is that
you’re using some sort of SpamBlocker software
that won’t let you forward ‘web-pix’: pictures that
were never actually in the e-mail you received,
but live somewhere out on the Internet where a
link in your e-mail can retrieve and display them
on command. Web-pix are sometimes harmless,
but they are also sometimes used by spammers
to target you for unwanted and annoying com-
mercial e-mail.
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  •  Forward these pictures (if you must) by right-
clicking the picture in your original received
e-mail, selecting Save Picture As… and saving
the picture on your desktop. Then, when you’re
editing the New or Forwarded Message, highlight
each of the red Xs in turn, and click on Insert »
Picture in the menu; click on Browse, choose the
saved picture from your desktop, and click open.
once you’ve sent the message, you can delete all
the temporarily-stored pictures from your desk-
top.

  • Occasionally, you’ll receive an attachment you
can’t open. If it’s a proprietary file format like
.psp or .psd, write the person who sent it to you
and ask them to send you a. jpeg or .pdf of the
attachment. If the file attachment says it is an
.eml file, save it to your desktop, and double-click
to open in outlook Express (this is usually only a
problem for people who are reading mail online,
but the mail was sent from an Outlook Express
user using the PoP3 protocol. You don’t have to
understand that last bit, just take my word for
it). 

  • If the attachment says it’s a .txt file, but Notepad
shows gibberish characters when you
double-click it, try saving it to your desktop,
changing the extension to .eml, and double-click
so outlook Express can open what is most likely
an html e-mail. If double-clicking doesn’t cause
Outlook Express to open, try highlighting the
saved file, holding down the Shift key on your
keyboard while you right-click the highlighted
file, and choosing open With; select outlook
Express from the drop-down list that appears. If
outlook Express isn’t in the drop-down list, it’s
probably not installed on your computer. Go to
Control Panel » Add/Remove Programs » Win-
dows Setup (or Add/Remove Windows Compo-
nents) and select Outlook Express; click OK and
follow the prompts to install it.

7. Hoaxes
You’re going to receive e-mail messages nearly

every day telling you about some heinous or heroic
thing done by someone you’d never have expected it
from. Please go to Snopes.com and check it out before
sending it on. 99% of the time, these stories are at
least exaggerations, if not outright lies. (Jane Fonda
did visit North Vietnam during the war, but there’s
no evidence she got anyone beaten or killed by
betraying them to their captors.) Please don’t add to
the Internet clutter by propagating lies and half-
truths. Just type a few pertinent words from the

e-mail you received into the Search box at Snopes,
and they’ll give you a list of current stories on the
Web on that subject, and tell you how much (if any)
of it is true.

8. File Size.
I routinely receive huge video and audio files

from people I really like, but I don’t have time to
wait for the downloads, even at DSL speed, and I
sure don’t have the hard drive space to store every
movie floating around out there. I delete them from
the Verizon e-mail server before they’re ever down-
loaded to my computer. Make sure you have a very
good reason for sending any e-mail larger than half
a megabyte (500kb). If in doubt, err on the side of
courtesy: send a link to the online copy of the origi-
nal file in a plain text e-mail, say in the Subject: line
that it’s a movie or audio link (give the subject of the
clip here, too), and say in the message body how
large the file is, even if it’s just in relative terms - “it
takes three to four minutes to download, but it was
worth it,” or words to that effect.

Media Notes
by Bill Petitt

Southeast Virginia Computer Group

Farewell Vista, Hello XP

How to make the switch back and deal with the
gnarly problem of transferring your Vista
e-mail, contacts, and user data back to the

old standby operating system
After you have been exploring Windows Vista for

about six months, you might decide that, you liked it.
Vista’s new navigation features will probably

grow on you. Vista’s appearance has it all over
standard XP, and there are tons of usability features
that beckon—after you turn off the incredibly annoy-
ing User Account Control that constantly bugs you
when you want to install programs or tweak things.

For example, you might love being able to shut
down with one click; you might like the junk filtering
in Windows Mail (Vista’s upgraded version of Out-
look Express); and you might appreciate the way you
can easily drag User folders (formerly My Docu-
ments) to a new location so you can consolidate them
with other data that you regularly back up.

For example, you might love being able to shut
down with one click; you might like the junk filtering
in Windows Mail (Vista’s upgraded version of Out-
look Express); and you might appreciate the way you
can easily drag User folders (formerly My Docu-
ments) to a new location so you can consolidate them
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with other data that you regularly back up.

Annoyances Will Probably 
Drive You Backwards

Unfortunately, small time-wasting annoyances in
Vista cropped up almost immediately. Auto-complete
of e-mail addresses in Windows Mail works only with
the 29 most recently used contacts (you might have
hundreds), and overall the program is slow. The
Search Indexer had an irritating tendency to start
when I watched an HD DVD, and despite of the
absence of multimedia files in a folder, those folders
showed useless columns for Artists, Tags, and
Ratings. As irksome as these things were, you might
consider them livable. A friend discovered that his
sound card’s drivers for ASIO (a high-performance
audio standard for recording musical instruments
and vocals) didn’t work well under Vista that the
balance tipped irretrievably him towards “downgrad-
ing” to XP.

The beta ASIO drivers may have been spotty, it
may have been a system configuration problem, it
may have been him--Vista is actually reputed to be
much better for Pro audio--but he decided that it was
time to revert to good old stable XP with its mature
driver support.

After about a year, that’s what I decided to do on
my main machine.

How About Dual Booting?
You might consider leaving Vista installed,

installing XP, and then dual-booting using a boot
manager that hides the OS not in use. Some users
have experienced the failure of Acronis’s Boot Man-
ager and of OSLBoot (included with the OEM ver-
sion of Vista) and that’s frustrating. I also lost a
Vista installation that I had been dual booting to –
just another example of this type of failure.

If you conclude that you really don’t want Vista
around anymore and decide to overwrite it. Here’s
how to do it.

First Steps
    The first step to reverting to XP is to save your
Vista data, the subtleties of which I’ll get into later.
After backing up the pertinent data, you should use
something like Acronis’s True Image or Norton
Ghost to make a backup of the entire Vista partition
in case you forgot to copy something. This little
fail-safe procedure has saved my tukus on more than
one occasion.

Next, move your program data (your documents,
images, and other files) to a safe location—that is, to
a drive that won’t be overwritten by your new XP

installation.
What about applications? Alas, the tricks I

describe below can’t be used for migrating apps from
Vista to XP. That step you must take after XP is
installed, and, sadly, you’ll have to reinstall your
programs one-by-one to be certain they’ll work right.

Moving Data
When you’re

ready to do it
(not yet!), mov-
ing program
data to Windows
XP i s  e a sy
enough. Instead
of XP’s My Docu-
ments, Vista
stores data in a
User folder that
will bear the
name of the cur-

rent user and contains subfolders for documents,
pictures, videos, contacts, and so on. Vista allows you
to relocate these folders by simply dragging them to
a new location. So, before you overwrite Vista with
XP, do the following:
1. Copy or relocate (right-button drag and select

Move) your User folder or folders to a partition or
drive that won’t be overwritten--for example, the
D: drive. Keep in mind that every user on the
computer will have their own folder, so you need
to relocate or copy all of them. And don’t forget
the Public folder.

2. If you’ve been using programs that allow it,
export data to a safe place for later import when
you’ve reinstalled XP. More on this later.

3. Once you’ve installed XP, either drag the user
folders back to XP’s My Documents, point My
Documents to the folders’ new location using
Properties, Target, Move, or simply access the
data where it resides.

4. Import your exported data back into your third-
party apps after you’ve reinstalled them.
There is data hidden in your User folders that

you may or may not need (the default e-mail reposi-
tory, for example, is here). To see it, open your User
folder, select Folder and Search Options from the
Organize menu, select the View tab, and make sure
Show hidden files and folders is selected.

Close the dialog box, and you’ll see a folder called
AppData; it can’t be moved like the other User
subfolders. Open it, browse it, and if you see any-
thing you might need, copy it to a safe place. (You
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could skip this step and grab it later if you discover
you need anything, since it will have been copied
when you made your backup image. But copying it
this way makes it easier to access.)

Don’t install XP yet! You’re nearly there, but a
few more details must be dealt with.

The Mail Mess
In my case,

transferring the
data I’d accrued
using Vista’s na-
tive apps back to
my XP apps was
the real problem.
You will have used
Vista nonstop for
however long you have had it. Just copy it back?
That’s not so easy, as Microsoft decided to revamp
(not for the better in my opinion) the way Vista and
Windows Mail stores messages and contacts.

Where Outlook Express stored messages in
database files and contact information in the sin-
gle-file Windows Address Book, Vista and Mail store
every e-mail and contact as a separate file--a more
versatile approach but also considerably less efficient
and inadvertently responsible for the auto- complete
bug I mentioned up front. In addition, it makes
Windows Mail very slow compared with Outlook
Express.

Vista Mail’s address export function worked fine
for the contacts. Before reinstalling XP I exported to
both vCards and a .csv (Comma Separated Values)
file, which is basically a text file with one record per
line and each bit of information separated by a
comma.

While vCards seemed like a good idea at first,
Outlook Express’s vCard import function lets you
add only one at a time, and if you drag and drop
multiple vCards into the program window, you still
have to click the OK button for every card. With
hundreds of e-mail addresses to copy, I soured on
that path to carpal tunnel in short order.

CSV import was much faster, and with the
exception of a couple of odd characters in the First
Name field, the Mail and Outlook Express fields
matched up perfectly, so I was able to restock the
Windows Address Book in XP in about 30 seconds.

Two Ways to Import E-Mail into XP
Finding an easy way to move my e-mail back into

XP proved more difficult. Outlook Express’s import
function won’t import Vista Mail’s .eml messages

wholesale. The following method is simple and
suffices--if you have a taste for the tedious.

You can save Vista Mail’s messages to a safe
place and then drag them directly into the Outlook
Express window. But if you have a lot of sorted
e-mail, you must manually recreate your folder
structure--which is where the tedium commences.
Here’s the step-by-step:
1. In Vista, save your e-mail repository to a safe

place on another partition or drive before you
install or overwrite Vista with XP. Find the
repository in: C:\Users\Username\AppData
\Local\Microsoft \WindowsMail\ Local Folders
(Username is your user name). You can redirect
the repository to another location by using the
Tools, Options, Advanced, Maintenance, Store
Folder function, or you can export in Mail format
to another location. I recommend the latter (or
both).

2. After you’ve installed XP, open Outlook Express,
open an Explorer window pointed to the safe
location you copied the .eml files to, select them,
then drag and drop them to the folder in OE
where you want them. As I mentioned, you must
recreate the folders yourself.
The above method works, but you, like me, might

have dozens of folders that you might have sorted
e-mail or have archived for particular projects, so I
really, really wanted a better way. Since I had Office
2007 with Outlook (any recent version of Office
Outlook will do), I hit on the idea of importing the
messages into Outlook from Mail under Vista, then
transferring them back from Outlook to Outlook
Express in XP. It’s a slightly convoluted process, but
it requires no tedious labor and works like a charm.
The procedure goes thusly:
1. In Vista, use Outlook 2007's Data Management

dialog box to create a new.pst data file, make it
your default, and then import the messages (not
addresses) from Mail. Make sure you save the
resulting .pst file to a separate partition that
won’t be overwritten when you reinstall XP.

2. In XP, install Outlook and use it to open the .pst
file you created in Vista and make it the default.

3. Fire up Outlook Express, choose Import, and
select the Outlook option; you should now be
good to go.
If you’re wondering why I don’t use Office Out-

look for my e-mail, I have two reasons: First, Outlook
Express is simple, it’s extremely efficient, and I’m
used to it. The other reason is that the Office version
of Outlook allows only one set of contacts. And yes,
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I tried installing Outlook Express on Vista, but all
the OE self-installers I possessed bailed after notify-
ing me that a newer version (Windows Mail) was
already installed.

Time for Your XP Install
After all of that prep, installing XP over Vista is,

in itself, not too difficult: Boot with your XP installa-
tion disc and install XP, overwriting Vista. And just
make sure to select the partition that Vista is on and
follow the prompts.

As I’ve said, there’s not a lot you can do about
migrating your applications back. If you were using
two separate PCs, you could use Windows Easy
Transfer or a similarly capable commercial product.
I didn’t consider that option, because I wanted a
lean, clean OS with an uncluttered Registry.

The solution is to reinstall your apps—which is a
pain, but it’s the best way to go.

Am I happy I moved back to XP? Very much so.
The time I save by using Outlook Express instead of
Vista’s Windows Mail is worth the switch by itself.
Personally, I think Microsoft spent too much time,
when it was developing Vista, in fixing stuff that
wasn’t broken and breaking stuff that worked. I’ll
take another look at Vista after SP1 ships, but I
don’t think I’ll be switching again for a while.

If you’d like to try Vista before removing XP, or
if you’re using Vista and would like to take a stroll
down memory lane to see just how efficient the older
OS is, download VMware Server or Virtual PC 2007
for free and try them in a virtual machine.

Passwords 101
by Carla S. Cawlfield

Houston Area League of PC Users

“Just because you’re paranoid doesn’t mean they
aren’t after you” 

–Joseph Heller, Catch 22

Joseph Heller should have had this quote
password-protected, because it was later used
by Kurt Cobain of Nirvana. I have been using

computers all my life, and the Internet since it was
made available to the public. So over the years, I
have set up jillions of accounts that required a
password. Creating passwords is easy; it’s remem-
bering them that can be hard. Here are some tips on
effective and simple password maintenance.

Rule #1
Do not share your personal passwords with

anyone. This includes spouses, kids, and co-workers.

Plan and Organize. 
Before you ever set up any passwords, think

about it. Your problem will be in remembering tens
to hundreds of passwords assigned to different
accounts. You may not always be at your own per-
sonal computer(s) where Cookies will fill-in the
password each time you access a program. Some
pre-planning will come in handy. (If you already
have lots of accounts with passwords you can’t
remember or maintain, a password tune-up is
needed. You can re-assign new well-thought-out
passwords to existing accounts, using the following
tips).

Get Cryptic.
Rather than just grabbing a password on the fly,

get creative. You can help manage the complexity of
passwords if you think deeply about old memories or
data that you have not shared with anyone. This is
way beyond the security questions asked at various
sites, i.e., questions like family birthdays /anniversa-
ries, your mother’s maiden name, your first pet’s
name, your favorite color. Forget all those. Rather,
consider combinations of partial words and numbers
that have meaning only to you. (See basic tips below
for specifics.) Doodle with them, create anagrams,
see if you can come up with a few that are cryptic to
anyone else, but easy for you to remember. If you
design them carefully, a few passwords may last you
for years.

Security. 
Accounts and programs fall into various levels of

security:
Highest Security—your personal computer,

email accounts, online banking, personal web pages,
eBay/PayPal, ATMs, etc. This is extremely valuable,
sensitive or personal data, the loss or corruption of
which would be catastrophic. See Rule #1. These
accounts deserve your most careful attention. The
flip side of password protection is Back up Your
Data! If someone does hack into your accounts,
having your data backed-up and stored outside of
your computer is a life-saver.

Medium Security—online photo storage sites,
travel search engines, birthday greeting programs. If
someone broke into these accounts, they might post
or retrieve vacation or other embarrassing photos,
but not much terrible damage can occur, unless you
are Rob Lowe, Paris Hilton, or Alec Baldwin.
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Low security—sites include online recipes,
weather info, television listings, newspaper sites,
and such. Why these sites even want your email
address and for you to log in is only for their own
data mining and marketing purposes. You are not
uploading anything, they are merely public retrieval
sites. Tip: Save yourself some hassles and create a
junk “throw-down” email address for these types of
sites, such as anonymous@hal-pc.org. (HAL-PC
/HALNet members can have more than one email
address at no extra charge.)

“I’m re-encoding this message every ten sec-
onds, so have your system keep up with us.”

David Bassom, Babylon 5
Rule #2

Do not share your personal passwords with
anyone. Sound familiar? If you truly cannot commit
to memory your most important passwords, as an
absolute last resort, record them and hide them
somewhere very private and known only to you.

Create passwords that are difficult to hack (see
basic tips), but that you can recall in an instant,
without writing them down somewhere. Contrary to
some “experts” advice, I am not an advocate of
writing passwords down where other persons have
access to your computer, either at home or at work.

It is okay to repeat yourself. You CAN use the
same password over and over on different accounts.
But be careful. If someone hacks your passwords
somewhere, if you have been careless about how you
repeated yourself, they will have access to your
highest security accounts. Use unrelated passwords
at the highest security level. For the medium and
low security accounts, the same passwords may be
okay.

Rule #3
Do not share your personal passwords with

anyone. This includes email requests you may get
from your bank, eBay, PayPal, etc. telling you to
reply to the message and create a new password
(these are almost always fake emails from scam
artists). No legitimate business will ever send you a
solicitation email asking you for your password. Did
you get the message?

Rule #4
Now go break Rules #1 through 3, but only after

you are dead. I recommend you record your pass-
words or secret location thereof in your Last Will and
Testament. The executor of your estate will need to
access your records in order to settle your affairs.

Include locations of paper files, electronic files,
online data sites, and necessary related passwords.
Rather than have this info actually typed into your
signed Will copy, just create an attachment page
that you can update as the file/password information
changes from time to time.

Three can keep a secret if two are dead.
–Benjamin Franklin

Good, Bad, & Ugly
Good password example—8U 3r Y6ng
Bad password example—hotstuff
Ugly password example—*&@%

Best Basic Do’s & Don’t’s:
1. Do back up all of your data and store it on remov-

able media, away from your computer.
2. Do use at least eight characters. The more than

eight, the better.
3. Do use a combination of upper and lowercase

letters and spaces.
4. Do use a combination of letters and numbers.
5. Do make sure your final password is a messed-up

jumble of characters.
6. Do make sure your final password makes abso-

lutely no sense to anyone else.
7. Do not use any real or fictional names or dictio-

nary words (this includes all languages!)
8. Do not use obvious dates, birthdays, anniversa-

ries, etc.
9. Do not use public or semi-public personal data,

such as house numbers, social security numbers,
phone numbers, ages, etc.
For a lot of specific do’s and don’t’s (if you want to

read really loooong articles about passwords), here
are some helpful websites:
http://geodsoft.com/howto/password/password
_advice.htm
http://www.microsoft.com/athome/security/privacy/
password.mspx?pf=true

© 2007 by Carla S. Cawlfield Reprinted from the
Nov./Dec. Issue of HAL-PC Magazine. Carla Cawlfield is
a long-term HAL-PC member and volunteer. Contact her
at carla@hal-pc.org.

Is Skipping OK, okay?
Q. When I change settings, at the bottom of the
screen it has the OK and APPLY buttons. I always
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click APPLY, then OK, but when I skip APPLY and
just click OK, it seems to do exactly the same thing.
Can I save a step and just click OK without clicking
APPLY?
A. Depending what you're doing, there may be a
valid reason to use APPLY versus OK, or both in
concert, so let’s take a look at what each button does:
APPLY saves any changes you make without closing
the dialog box or window. So you would click APPLY
and not click OK if you make changes and need to
make additional changes on the same screen. Click-
ing OK saves any changes and closes the dialog box,
so you would click OK if you're making one change
and then want to exit.

Most people click APPLY > OK out of habit, as a
two-step operation to save and exit, but technically,
it's not always necessary—again, depending what
you're doing at the time. 
Q. I’ve been to the AVG Web site, but I can’t find the
free version you’re always talking about. They must
have it pretty well hidden. Can you point me to it,
Mr. M?
A. The free version of AVG AntiVvirus continues to
be my favorite anti-virus program. It automatically
updates daily, has a scheduler so you can run full
system scans in the middle of then night, and you
can’t beat the price. Most vendors do tend to hide
their freebies, and the good folks at AVG are no
exception, but you’ll find the free version located at
http://tinyurl.com/yo9npk. A paid version is also
available, and you’ll find a features comparison of
the free versus paid versions on the site, as well.
Q. Can you explain the difference between “Read
Only,” “Hidden,” and “Archive” options for files?
A. When you right-click a file and select Properties,
near the bottom of the Properties dialog box you’ll
see the Attributes section. The items you refer to are
three check-box flags or what are called file attrib-
utes that describe various characteristics of a file.
Technically, it’s a bit more complicated than that,
but for our purposes, and so my head doesn’t ex-
plode, I'm going to keep this as simple as possible.

The Read-Only attribute, as its name implies,
causes a file to be “read-only,” meaning that you can
view it, but you cannot edit or delete it.

The Hidden attribute causes a file to be invisible
under certain circumstances, such as when lists of
files are displayed or when there’s a full moon. For
example, there are certain files within Windows that
most of us have no business using, so those are
typically hidden. No good can come from most of us
tinkering with hidden files, so to protect us from

ourselves, Microsoft designates certain files as
“hidden.” System files are generally hidden files, as
are files that are critical to the performance and
operation of Windows.

The Archive attribute was created by Microsoft to
allow developers to quickly determine whether a file
requires a backup (archive) copy. The Archive attrib-
ute is established whenever an existing file is either
overwritten or modified. The idea, in general, is to
signal a backup program that a certain file needs to
be backed up. A backup program may not know to
save a new or modified file without the addition of
the Archive attribute.

Mr. Modem’s DME (Don’t Miss ‘Em)
Sites of the Month

APA Help Center
At varying times, many people experience some

form of depression, anxiety, or other psychological
challenge(s). The American Psychological Associa-
tion's Web site provides useful links to help us learn
about dealing with anxiety and stress, practice
techniques for healing our bodies with our minds,
and when additional assistance is warranted, locate
a therapist.

http://tinyurl.com/3yljbu

Worst Jobs in History
The Web site behind the U.K. television show

“The Worst Jobs in History,” which explores the
most miserable professions of the past 2000 years. If
you think you’ve got it rough, think of laborers
during the free-spirited Middle Ages or the swinging
Victorian era. Good times, indeed. Each job is de-
scribed in humorous and occasionally shocking
detail. Fuller, Bog-Iron Hunter, Wattle-and-Daub
Applier—they’re all here.

http://tinyurl.com/2tmf5c

Virtual Vaudeville
Take an entertaining trip back to the 19th

Century, where the past meets the future thanks to
the convergence of nostalgia and technology. There
are many fun features on the site, the highlight of
which is the Virtual Vaudeville Live Performance
Simulation System. Sounds like a party to me! Learn
all about the development and production of this
concept, which preserves online live theater for
future generations to experience and enjoy.
www.virtualvaudeville.com

Treat yourself to a subscription to Mr. Modem’s
award-winning, weekly computer-help newsletter! Helpful
PC tips, great Web sites and personal, plain-English
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answers to your questions by email! To view a sample
issue or subscribe, visit www.MrModem.com. 

OpenOffice.org—How Suite It Is
(An Introduction)

by Herbert Wong, Jr.
North Orange County PC Users Group

You need new software for your new computer.
The list price for a full version of Microsoft
Office Professional 2007 is $500 and an up-

grade in a couple of years will cost another $300.
That $800 DVD is $200 more than what you paid for
your entire computer, monitor, keyboard, mouse,
speakers, and Windows Vista! 

There has to be a better way! There is, it’s called
OpenOffice.org 2, and it is free because it’s open
source (based on Sun Microsystems StarOffice).
OpenOffice.org (currently version 2.3) components
are Writer, Calc, Base, Draw, Impress, and Math. 

It is available in versions for all of the major
operating systems such as Windows, Macintosh,
Linux, Unix, etc. There are many native language
versions (including Albanian, Afrikaans, Arabic,
Armenian, Azeri, Basque, Bengali, Bosnian, Breton,
Bulgarian, Burmese, Catalan, Chinese, Czech,
Croatian, Danish, Dutch, Dzongkha, etc.) as well. 

OpenOffice.org uses the new international
standard for documents, OpenDocument format
(based on XML). This allows any OpenDocument
compliant software to edit your files. You can, also,
directly save documents as PDF (Portable Document
Format) files with the built-in converter. 

Writer
Writer is a full featured word processor. You can

create anything from simple notes to complex docu-
ments with table of contents, indexes, diagrams,
mathematical formulas, text frames, linking, biblio-
graphical references, tables, illustrations, etc. 

The answer to your first question is yes.
OpenOffice.org Writer can read Microsoft Word
documents and save documents in Microsoft Word
format to exchange with lemmings. Documents can
be directly connected to email software or exported
as HTML for web pages. 

Wizards simplify creation of a Letter, Fax,
Agenda, Presentation, Web Page, Document Con-
verter, Euro Converter, Address Data Source, etc.
AutoComplete suggests words (at least ten letters
long) as you type. 

There are even simple tools to help your adjust-
ment to OpenOffice.org. “What's This?” is an optional

toolbar icon (an arrow pointing to a question mark)
that will provide extended help-boxes when moving
the mouse-cursor over the toolbar icons. This allows
standard short toolbar icon labels (ex. - “gallery”) to
be the default and extended help (ex. - “Opens the
Gallery, where you can select graphics and sounds to
insert into your document”) can easily be obtained
when needed. Another option is to turn on the
extended help-bubbles as the default. 

Calc
Calc is an easy to use all-purpose spreadsheet.

You can create anything from simple tables to
complex spreadsheets suitable for professional data
miners or number crunchers. 
Wizards and templates simplify creation of advanced
functions. Scenario Manager automates “what if”
analysis. Design-Themes and Styles-And-Formatting
improve the appearance of cells. 
The answer to your first question is yes. OpenOffice
.org Calc can read Microsoft Excel documents and
save documents in Microsoft Excel format to ex-
change with lemmings. 

Base
Base is a new addition to the OpenOffice.org 2

suite. It is a database that allows you to use your
own database or Base’s HSQL database engine
(storing data in XML files) to create and modify
tables, forms, queries, and reports. 

Wizards (ex. - Report and Form Wizards), Design
Views, and SQL Views simplify the creation and
manipulation of databases. 

“For more advanced requirements, BASE sup-
ports many popular databases database natively
(Adabas D, ADO, Microsoft Access, MySQL), or any
database through industry-standard ODBC and
JDBC drivers. It also supports any LDAP compliant
address book, as well as common formats such as
Microsoft Outlook, Microsoft Windows, and Mozilla.”

Draw
Draw is a versatile application that creates

graphics and diagrams. Draw supports various
functions for texture, perspective, transparency,
lighting effects, 3D object creation, etc. 

You can easily create flowcharts, organizational
charts, network diagrams, and the like with Smart
Connectors. 

All common graphics formats (ex. - BMP, GIF,
JPEG, PNG, TIFF, and WMF) can be imported.
Draw files can be used to create .SWF (Flash) files
with the built-in converter. 
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Impress
Impress is a slide-show presentation program

(like Microsoft PowerPoint). Animated slides, 2D/3D
fonts, diagramming tools, etc. help create interesting
presentations. 

The answer to your first question is yes. Open
Office.org Impress can read Microsoft PowerPoint
files and save documents in Microsoft PowerPoint
format to exchange with lemmings. Impress files can
be used to create .swf (Flash) files with the built-in
converter. 

Math
Math is an equation editor that allows complex

formulas to be embedded as objects in Writer, Calc,
and Impress. 

Conclusion
As you can see, OpenOffice.org 2 is a full set of

office productivity applications. No, it is not
Microsoft Word, WordStar, NotePad, Corel Word-
Perfect, or any other program that you have every
used. It is a powerful, useful, and continuously
evolving tool that is suitable for nearly everyone. 

OpenOffice.org 2 is free to try, free to own, and
free to upgrade. Save your $800 to buy your entire
next computer and to give a donation to the
OpenOffice.org Project as well! If I could only re-
member that URL... 

From the December 2007 issue of Orange Bytes,
newsletter of the North Orange County Computer Club.

Do Your Drivers Need Updating?
by Bill Allen

North Orange County PC Users Group

Have you installed new programs or peripher-
als recently? Seeing strange actions by your
printer or display screen? Multimedia acting

weird? You may need to update your computer
drivers. Drivers are the software programs that
interface peripherals with your operating system,
including even certain “peripherals” located on your
motherboard. While Windows includes drivers for
most peripherals, they may not be the most current
ones you need. That, plus degradation of your drivers
during computer use, means you may need new
drivers. For example, using the free scan provided by
driveragent.com I counted over fifty drivers on my
PC, ten of which needed critical updating. 

There are a number of free driver scans on the
Internet at such sites as www.driveragent.com
mentioned above, driverguide.com, and at Driver
Headquarters (www.drivershq.com ) specifically for

upgrading from Windows XP to Windows Vista.
Interestingly, three other driver websites each sent
me to driveragent.com for scanning and repairing my
PC. It’s not hard to see why—the Touchstone Soft-
ware Corporation product at driveragent.com is
simple, quick, and easy to understand. I decided to
spring for the subscription fee ($30 for a one-year
membership) to clean up my PC. 

It was a simple four step process: (1) run the scan
to identify the deficient drivers shown with big red
“X”s. (I had about ten, including four for USB alone.);
(2) the driver tabulation shows not only the state of
each driver, but also any ready uploads, if available,
as little floppy disk icons; (3) just click the floppy
icon and download the file which will be in either
“.exe” or “.zip” format; (4) finally, install each file just
as you do any application program. It took me less
than a half an hour to download and install the
drivers I needed. Once that was completed I ran the
scan step again to verify I had updated all the
drivers possible. It showed no red “X”s this time. 

For more information on driver updating from
people who know more about the subject than I do,
try: http://www.cyberwalker.net/article/449. I
learned I not only needed updated drivers, but I also
needed guidance in which ones I should replace,
where the drivers are made available (hopefully for
free), and how to install them. Driveragent.com
made the job simple, easy and quick. You will find
keeping your drivers up to date, while important,
can be relatively easy to do. 

From the December 2007 issue of Orange Bytes, newsletter
of the North Orange County Computer Club.

Exploring Windows Explorer
by Jim Sanders

North Orange County Computer Club

Everyone using Windows XP uses Windows
Explorer all the time. Some use it in what I
consider the true form. Some, because you use

it under the title of ‘My Computer.’ And all of us
when we are using Internet Explorer, because
Windows Explorer is an integral part of Internet
Explorer. I continue to be surprised at how many
people do not know that you can right click on the
start button and go directly to Windows Explorer. I
prefer that to the ‘My Computer’ path because it
brings up Windows Explorer with the left hand pane
of the window displaying the tree structure of the
files. It surprises me that many people who use the
‘My Computer’ path don’t know that they can bring up
the tree pane by clicking on the folder button in the
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taskbar.
Something that is almost as sad, is how many

people live with the default settings of Windows Ex-
plorer. One of the first things that I do with a new
installation of Windows AT, is to open Windows Ex-
plorer, go to the ‘View’ menu and click on ‘Details.’ The
next step is to open the ‘Tools’ menu, and click on
‘Folder Options.’ When the ‘Folder Options’ window
opens click ‘View, then on ‘Display the full path in the
title bar’ to place a checkmark in the box, click on
‘Show hidden files and folders’ to put the bullet on that
line, click on ‘Hide extensions for known file types’ to
remove the checkmark. Personally, I think Microsoft
did new users, in particular, a major disservice by
having the last item set by default. The resulting
confusion of having two or more files with the same
name, and not differentiated by the file extension,
causes a fair amount of distress in users that are not
sure which file to choose. I like to see the protected
operating system files but you may be more comfort-
able leaving them hidden. The last item to check is
show ‘Control Panel in My Computer.’ Then click on
‘Apply,’ wait for it to finish, then click on “Apply to all
Folders,’ then click on ‘OK’ and you’re done.

As a result of the above actions, the right hand
window pane will now have four columns: Name, Size,
Height, and Date Modified. The sort will be set to
alphabetical by name, numbers and special characters
first, then A to Z. If you want the sort to be Z to A,
click on ‘Name’ at the top of the ‘Name’ column. If you
want the sort to be by ‘Size,’ click on ‘Size’ at the top of
the ‘Size’ column and Windows Explorer will sort the
folder by File Size, smallest file first. To reverse the
order, and place the largest file at the top of the list,
click on ‘Size’ again. The same procedure works with
the ‘Type’ column and the ‘Date Modified’ column.
There is a feint divider bar between each of the col-
umns located in the horizontal bar where the names of
the columns are located. One of the easiest ones to find
is one space to the right of the column headed ‘Size.’ If
you move the mouse cursor to that area you should see
a double headed arrow appear. If you then click and
hold the left mouse button, you can adjust the width of
the edge of the columns. The width of the ‘Name’
column is often too narrow to show the complete file
name. Having the complete path displayed in the
address bar is often useful when you need to copy and
paste that path into other applications.

When you have a lot of files in a folder, there is a
navigation shortcut in the ‘Name’ column that too few
people seem to know about. When you first open a
folder, the display will show any other folders (or what

should really be called subdirectories) within that
folder followed by files, starting with the letter ‘A.’ If
you need to get to a file that starts with a letter T,’ you
might have to scroll through several hundred files to
get there. There is a faster way. Click on the first file
in the folder to highlight it. then type the first letter of
the file that you wish to find, in this example the
display would immediately jump to the first file that
starts with the letter ‘T.’ If you know what you are
searching for, and can type quickly, you can follow the
first letter with the second letter of the name and it
will take you to that point instead.

I think initially setting all folders on a hard disk to
the detail view is the best starting point and is best
suited for the majority of folders. Windows XP allows
you to customize the view of each and every folder and
will remember what settings you assigned to a given
folder. For instance, for folders that contain photos it
is often more useful if the thumbnail view or the film
strip view, is chosen, so that you can see what each
picture actually is. The advantage of the thumbnail
view is that you can find images quicker than in the
filmstrip view. The advantage of the filmstrip view is
that you get a line of thumbnails across the bottom of
the pane and a larger view of whichever thumbnail is
highlighted. There are also mouse click arrow’s that
allow you to view the next or previous image. Don’t
forget that you can right click on any of the thumb-
nails and bring up a whole new menu of things that
you can do with the image.

Everybody should learn how to do file housekeep-
ing on their computer disk.

Everybody should learn how to do file housekeep-
ing on their computer disk. Being able to move files
from one folder to another, to copy files from one folder
to another, to create new folders, and several other
functions along those lines can help you keep your
data organized. It should be noted that most of these
functions can be accomplished in more than one
fashion. For instance, if you wished to copy a file from
folder A to folder B, you would first select the file by
left clicking on it which will cause it to be highlighted.
You could then open the ‘Edit’ menu by clicking on
Edit,’ then click on ‘Copy,’ then click on the destination
folder, then click on ‘Paste’ in the edit menu. A copy of
the file will appear in that folder. Alternately, you
could use some of the keyboard shortcuts.

You could highlight the file, press and hold down
the Ctrl key and then tap the ‘C’ key. This will copy
the file to the temporary holding bin called ‘clipboard.’
You would then highlight the destination folder, press
and hold down the control key, then tap the ‘ V key
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which will paste the file from the clipboard to the
folder you highlighted. Another method is called ‘Drag
and Drop.’ In this method you move the mouse cursor
over the file you wish to copy, left click and hold the
mouse button, move the mouse to drag a ghost image
of the file over the top of the destination folder and
then release the left mouse button. There are many
more features to cover but this is all the room I have
for now. We will do more later. 

This article has been provided to APCUG by the author
solely for publication by APCUG member groups.

From the DealsGuy
by Bob (The Cheapskate) Click

Greater Orlando Computer Users Group

I’ve used FedEx twice and it was a
complete disaster. The first time,
a few months ago, they delivered

the packages I sent my son to the
wrong house, which was actually
unoccupied, but the tracking said it
was delivered. Luckily he found them
three days later when checking that
house (he owns it).

I recently sent two more packages to my son’s
home. I tracked the packages on the Web site and
when it showed the packages on the truck for delivery,
I called to make sure their gate was open that day.
They live a quarter-mile back from the road with a
gate at the entrance. The package was not delivered
that day, but at 6:46 pm the tracking showed it would
be delivered the next day. At 8:30 pm the next night
and no change with the Web site tracking, I called
FedEx to see why it was not there and was told they
had no way to communicate with the driver, but the
package would not be delivered that late. My son
closed the gate. 

FedEx called me the next morning to give an
approximate delivery time, but discovered that the
delivery was actually made the night before at 9:06
pm. My son hurried to look, but the packages couldn’t
be found. My son’s house is not visible from the gate at
night because it’s back down the drive, so obviously
with the gate closed, the packages were left beside the
road, but there is a large sign on the gate with the
address and phone number to call. Why can’t they
communicate with their driver? They said that be-
cause I didn’t request a signature, I am out of luck.
Actually, they are out of luck from now on with my
money. I submitted a claim anyway.

Problem Resolved
Last month I mentioned a reader had tried the free

Advanced WindowsCare Personal (from my November
column), but in order for it to fix the problems, he
needed to upgrade to the pay version, so he stopped
there. I later received a message from Ira Wilsker
telling me it worked fine without upgrading, and that
he had demonstrated it to their group. My proofreader
also tried it with no upgrade demand, so I downloaded
it and it removed what it found without upgrading to
the pay version. I don’t know where my reader went
wrong, but he’s going to try it again. Sorry for the
mixup.

A Firefox Add-on
iMacros for Firefox was designed to automate

online activities within the Firefox web browser. With
iMacros, users can create macros to automatically
check the same sites every day, remember passwords,
complete web forms, and upload or download files,
among other activities. They say, “Whatever you do
with Firefox, iMacros can automate it.” Notable
examples include stockbrokers who create macros to
extract online stock quotes, shoppers who use them to
automatically compare prices at online stores and
website owners who use them to get daily downloads
of their page rankings.  

iMacros for Firefox allows users to share macros
and scripts in a way similar to how they share book-
marks on the many social book marking websites.
After creating a new macro, users can use just one
click to share it with their friends as a link, or by
distributing the link via e-mail and social book mark-
ing websites. Also, by embedding it in a website or by
blog for public access. Script sharing is now so popular
that iOpus has even created a special site for script-
sharing on <del.icio.us >.

The iMacros for Firefox software is free for per-
sonal and commercial use. Users may opt to upgrade
to the business version with guaranteed response
times and advanced features. Additional information
and the software download link are available online at
<http://www.iopus.com /imacros/firefox>. Alterna-
tively, the software may be downloaded directly from
the official Mozilla site for extensions at
<https://addons.mozilla.org/en-US/firefox/addon
/3863>.

Help For Your Video File Conversion
Video Mobile Converter v1.0 supports digital video

files in the following formats: .AVI (audio video inter-
leave), .asf (advanced systems format), .mov (Quick-
Time movie), .mpg/.mpeg/.mp4 (moving pictures
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experts group) and .wmv (windows media video). Once
you choose a video, Video Mobile Converter loads the
video and lets you define how much video to convert.
Users also have control over the video and audio
quality during the conversion process. Users control
the height and width of the video, its frame and bit
rate as well as its overall quality. Users also control
the sample rate, bit rate and overall quality of the
video’s converted audio, along with the option of
splitting video files during the conversion process
enabling very large video files to become smaller and
more easily managed.

Lastly, Video Mobile Converter can output the
converted video in the following formats: .3GP and
.3G2 (for use on 3G network mobile devices that use
GSM or CDMA network protocols), .mp4 (for use on
mobile devices, such as iPods classic, iPod nano, iPod
touch, iPhones, cellular phones and other mobile
devices), and .psp (for use on Sony PlayStation
Portables).

Video Mobile Converter v1.0 runs under all ver-
sions of Microsoft Windows, including Vista and costs
$29.95 (USD) for a single-user license. User group
members get a 20% discount. For some reason they
didn’t respond to my request for the special ordering
procedures so, you can e-mail Michael Kaba <mailto:
sales@geovid.com>. Could be the because of the
holidays. Licensed users are entitled to the fully
functional copy of the software, and free updates.
Further information, as well as a free, fully functional
evaluation copy is available from <www.videomobile
converter .com>. For more information: <www.geovid
.com>.

Download link: <http://www.videomobileconverter
.com/download/video mobileconverter.exe> (9.3 MB) 

Help For Your Web Site
Our software package, SeoAdministrator, is a

popular professional tool for webmasters and SEO
specialists. We released a new module called “Site
Analyzer” that will be of interest to all webmasters
including those who look after personal websites. The
new module helps you to keep a website free of errors
such as broken links. Regular use of Site Analyzer will
ensure that problems are quickly and easily spotted so
they can be fixed. Download a free demonstration of
our easy-to-use tool from here. <www.seoadminis
trator.com/seoadministrator.exe>

Site Analyzer, Developed by FlamingoSoft of
Vancouver, BC, is designed to automate the vital web
management task of monitoring and improving web
site performance. 

Site Analyzer performs comprehensive scans of a

specified website and alerts web managers to a range
of common problems including broken links, faulty
image links, errors in HTML code and missing meta
tags using a variety of report formats. Site Analyzer
can also create sitemaps in both human and machine
formats ready for uploading. The link vendor will be
able to see which pages are “overloaded” with external
links and perhaps suspend link sales on those pages.
System Requirements: Windows95/98/ME/2000/XP
/Vista

Priced from $70 (Standard) to $150 for Expert
edition, we are offering this great software to user
group members at 50% discount ($75 instead of usual
price of $150) which includes lifetime support and free
upgrades. Use this link <https://usd.swreg.org/cgi-bin
/s.cgi?s=1613&p=1613seo&v=3&d= 0&q=1&t=> for the
50% discount. Check their Website URL for full info.
<http://www.seoadministrator.com/>

Pacific Business Centre, Att: FlamingoSoft, #101 -
1001 W. Broadway

Suite 381, Vancouver, BC V6H 4E4, Canada 

Easier Way To Remove USB Devices
USB Safely Remove enhances the native Safely

Remove function in Windows and enables you to
remove and unplug any USB removable device in one
mouse click or hotkey. It can give correct names to the
devices, lets you rename them and find out what
application or process is locking the USB device,
preventing it from safe removal. It’s easy to unplug the
wrong one by mistake because many of them have the
same name. Unlike the native Windows option, USB
Safely Remove shows all USB devices currently
plugged into the computer and lets you remove any of
them and the program gives correct names to the
devices on its menu. The software is primarily aimed
at those users who have more than one USB device.

USB Safely Remove 3.2 runs under Windows 2000,
XP, 2003, Vista and is available immediately for $20
(US) from SafelyRemove.com. User Group members
can purchase the program at a 25% discount. Use the
coupon code: CUG25 on the Buy Now page. Licensed
users get unlimited functionality without nag screens,
free technical support by e-mail and free lifetime
upgrades. More information on the product, as well as
a free trial copy is available from <http://safelyremove
.com/ug>.

Download link: <http://safelyremove.comusbsafely
removesetupug.exe> 

That’s it for this month. I’ll have more new product
announcements on my Web site (most not offering a
discount). Meet me here again next month if your
editor permits. This column is written to make user
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group members aware of special offers or freebies I
have found or arranged, and my comments should not
be interpreted to encourage, or discourage, the pur-
chase of any products, no matter how enthused I
might sound. Bob (The Cheapskate) Click <bobclick at
bellsouth dot net>. Visit my Web site at <http://www
.dealsguy.com>

This and That
by Elizabeth B. Wright

Computer Club of Oklahoma City

Have you accessed the WindowsXP “Restore”
option to reset your computer to an earlier
time? We often need to do this when things go

haywire after installing some new software. Fiddling
around with old programs or offbeat wares can some-
times land you in hot water operating wise. I found
myself in just such a mess not long ago. Fortunately I
had made a restore point prior to installing the rene-
gade software, so I was able to use it to get things back
to normal. Well, almost.

What happened next:
One of my oldest and most valued programs is

CorelPaint. Suddenly, after going through the restore
procedure, I began getting an error
 message plus having the program refuse to open when
I double clicked on the desktop shortcut icon. This
applied to CorelDraw as well. The error message said
something about trying to install the program, then it
would go through some strange digital machinations
before rolling everything back and giving up. Strangely
enough though, if I double clicked on a .jpg or .tif file
in Explorer, the files would open the program with no
difficulty. Several days were spent opening graphic
files in this manner when it suddenly dawned on me
that perhaps the programs might open from the
executable files directly. Sure enough, when I went to
them, again in Explorer, they both opened like clock-
work. So why did it take me several more days to
figure out that the icons on my desktop had some way
become corrupted? I don’t want to know the answer to
that one.

Anyway, after deleting the icons, new ones were
put in place by right clicking on the executable files in
Explorer and double clicking the “Send to desktop”
option from the menu. Usually the names given icons
made in this way are not the best, so they usually get
changed to something more useful on my computer.
Often part of the name is “shortcut”. Who needs that?
It’s fairly simple to change the name. Just click once
on the icon, wait long enough so that the computer

doesn’t interpret the next click as a double click, then
the icon text will be in “Edit” mode. You may have to
experiment with the timing for this since not all “mice”
are set for the same response time. The two clicks need
to be fairly close together, but not close enough for a
double click. Once in “Edit” mode you can type in
whatever name that makes better sense to you.

We should all know by now that if there is a curved
arrow in the lower left corner of the icon then the icon
is a shortcut to the executable file, not the program or
file itself. Be very careful. Sometimes there actually
are icons for executable programs placed on your
desktop when the programs are installed. Those icons
will not have the curved arrow. Don’t delete them
unless you want to get rid of the program itself. This
applies also to other things you might have placed on
the desktop yourself, such as graphic or document
files. It might be wise to leave those names in their
original form. It might also be a good idea to examine
the icons on your computer to see how many, if any, do
not have the curved arrow. Chances are there won’t be
many, possibly none. It is helpful to know if there are
any that reflect actual programs or files, just to keep
yourself informed about your own computer system.

It always pays to figure out what your computer is
up to. Since it lives a life separate from yours it is
often not possible to tell just what it has been doing in
your absence. With the new powerful operating sys-
tems, many, many things go on in the background
when the machine is powered on, whether you are
there or not. Supernerds probably have eliminated
many of the automatic actions, but most of us just
muddle on, thankful that the computer runs at all.

From the October, 2007 issue of the I/O Port Newsletter.
Obtained from APCUG with the author's permission for
publication by APCUG member groups.

Society News
January Meeting Notes
by John McMillan, secretary

Steve opened the meeting announcing that mem-
bers whose dues are in arrears should see him.
The next Planning meeting will be held Febru-

ary 5th at Sally’s house. He pointed out that the new
format for the Monitor, initiated for 2008, has resulted
in lower paper costs and cut our mailing charges
almost in half. Printing difficulties that resulted in a
black and white cover are thought to have been re-
solved so a color cover is anticipated.

John McMillan reported that 160 books (less than
1% of the books on hand) have been catalogued. He
hopes to have 2 helpers on January 12th when the
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work continues. 
The Society will meet at the Brighton Library on

the 12th of Feb. Mike Lavelle has a commitment from
the author of Why Software Sucks for a presentation
via an internet hookup at that meeting. Mike would
welcome thoughts or ideas for future programs.

Carl Schmidtmann has planned a meeting for
January 19th from 1:30 - 4:00 PM at the Greece Town
Library to help people load Linux onto their comput-
ers. Although he has a list of possible attendees, he
asked for verification to be sure there are enough
extension cords available. He recommends that target
computers have a separate 10 to 15 GB partition to
contain Linux software and related files. Things you
need to prepare for and links to helpful information
are on the web at www.faultline.com/LinuxInstall
.html 

After the social break, Arpad apologized for chang-
ing the topic from Newsletter Creation to Virtual
Computers. This was necessitated when his cell phone
containing slides and pictures for the Newsletter
presentation was stolen.  He did not use slides but
demonstrated some of the features of Microsoft’s
Virtual PC using his laptop and projector. 

Software from V M Ware might provide more
extensive capabilities but Arpad uses Microsoft’s
version that is free. It can be downloaded from
Microsoft.com by searching the download section for
Virtual PC 2007. It has no blocked features like VM
Player, which is a free VM product. 

Arpad described Virtual PC as a program that
emulates hardware and bios to create a separate com-
puter within your computer. The physical computer is
called the host while the virtual PC is considered a
guest and both can run simultaneously. A guest
computer can be set to run in the foreground or the
background and if in the background, its priority can
be adjusted  Virtual PC software requires about 50 Mb
of hard disk space and can run any operating system
written for an Intel 286 processor or better. Additional
space is required for the guest system and you should
have a legal copy to install for emulation. Arpad has
emulated Windows operating systems from version 1
through Vista plus Linux, and OS2 Warp on his
desktop computer. 

Advantages of running virtual machines are that
a guest crash will not take down the host. The state of
the guest machine can be saved which is an effect like
instant hibernation.  Arpad felt this was a great way
to try Linux. The hard drive from an older machine
can be added to an XP machine so DOS programs can
be run in a virtual environment. Virtual machines can

be deleted removing all traces of their existence.
Hard drives are also emulated by creating files

that are free of restrictions of the host machine. That
is the host may be running NTFS but the guest may be
using FAT 16, Fat 32 or Linux file definition. File
sharing between the host and a guest can be done by
dragging and dropping. 

The screen resolution of the guest machine can be
anything up to the resolution of the host. Higher
screen resolution will result in a bigger screen view
even if not run at the highest setting. In fact Arpad
changed the resolution of the guest to make it easier to
see the projected view.

He warned that emulators do not adapt well to
gaming or 3D video because currently they do not link
directly to graphics cards. Peripherals can be emulated
but will not produce external media if they do not exist
on the host machine. For example the guest program
may use a 3.5 inch floppy but if the host does not have
a floppy drive, physical disks can not be read or
written.  

Newer machines (less than a year old) have proces-
sors and mother boards that are designed to run
virtual machines by reducing the emulation software
overhead in the guest program.  Intel or AMD dual
core processors with a minimum of 1 GB of RAM are
ideally suited for Virtual PC because the host and
guest operate at the same speed but on different
processors. 

Arpad did a great job presenting a highly technical
concept. Mere words can not create the visual impres-
sion of being there to personally experience the demon-
stration. Nor will the summarization of an hours
presentation include all of the details. For the best
results, you should be there.

Lighter Side
Customer: “Hello, yes, my system is crushed!”
Tech Support: “Crushed?”
Customer: “Yes, that is what I said, crushed.”
Tech Support: “Oh, your system has crashed...”
Customer: “Yes, I cannot do anything, my mouse will
not work, and I can’t see anything on the screen. I
need it fixed now!”
Tech Support: “Ok, I need some history on this prob-
lem. What was the last thing you did before the system
crashed?”
Customer: “Well, after I stood on the computer to hang
a picture, my machine was crushed.”
Tech Support: “Oh, so your system has been crushed...”

Tech Support: “Well, let me look up your account
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information to make sure we have the correct pass-
word.”
Customer: “Ok.”
Tech Support: “Hmmm...let’s re-enter your password.”
Customer: “Ok.”
Tech Support: “All right. Your password is ‘XYZ123‘.”
Customer: “Oh, that’s what I have written down, but
that’s not what I put in.”
Tech Support: “What did you put in?”
Customer: “‘FURBY’.”
Tech Support: “Why did you do that?”
Customer: “Because I didn’t like yours.” 

Customer: “I’m sorry. I think I just deleted the In-
ternet!”
Tech Support: “That’s ok. We have it backed up here
on tape somewhere.” 

Customer: “I think I broke the Internet!”
Tech Support: “So it was you!”
Customer: (click) 

Customer: “I just re-crashed and re-burned my com-
puter, and I need some help getting my Internet to
work.”
Tech Support: “You did what now?”
Customer: “I re-crashed and re-burned my computer.”
Tech Support: “Well, maybe that’s why it’s not work-
ing. It’s in pieces and on fire.”
Customer: “Huh?”
Tech Support: (sigh) 


